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Word Module 01

	1. Pressing DELETE removes the character after the insertion point.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-54

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.1.3 - Copy, cut, and paste text.

	CORPORATE STANDARDS:  
	1820 - Delete text.

	TOPICS:  
	New Perspectives Series: Inserting a Picture and Adding Alt Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 9:41 AM

	DATE MODIFIED:  
	7/30/2019 10:01 AM






	2. To provide emphasis to text, you can apply bold.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-41

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	630 - Bold text.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 10:12 AM

	DATE MODIFIED:  
	7/30/2019 10:20 AM






	3. To remove the spelling change indicator under a word, you must accept the suggested change.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	False

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-10

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.2.2 - Correct spelling and grammar.

	CORPORATE STANDARDS:  
	2357 - Ignore suggested spelling change.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 10:26 AM

	DATE MODIFIED:  
	7/30/2019 10:30 AM






	4. When you click the Font Color arrow to change a font color, Word displays a palette of Theme Colors and Standard Colors.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-42

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.2 - Change document themes.

	CORPORATE STANDARDS:  
	840 - Change the font color.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 10:30 AM

	DATE MODIFIED:  
	6/18/2020 2:14 PM






	5. To insert a picture into a document, you open the Pictures pane and select one from a gallery of images.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	False

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-51

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.6.1.2 - Insert pictures.

	CORPORATE STANDARDS:  
	2565 - Insert a picture from a file.

	TOPICS:  
	New Perspectives Series: Inserting a Picture and Adding Alt Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 10:34 AM

	DATE MODIFIED:  
	6/18/2020 2:15 PM






	6. To create a new document, you can start with a blank document or a template.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-27

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.1.1 - Create a blank document.

	CORPORATE STANDARDS:  
	1346 - Create a blank document.

	TOPICS:  
	New Perspectives Series: Creating an Envelope

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 10:38 AM

	DATE MODIFIED:  
	6/18/2020 2:23 PM






	7. Each time you click the Save button on the Quick Access Toolbar, Word displays the Save As dialog box so you can specify the name and location of the document.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	False

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-7

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.7.1 - Save a document.

	CORPORATE STANDARDS:  
	3641 - Save a document.

	TOPICS:  
	New Perspectives Series: Saving a Document

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 10:43 AM

	DATE MODIFIED:  
	6/18/2020 2:24 PM






	8. Alejandro needs text to appear as if it were written in cursive. He can change the font of the desired text to achieve this.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-39

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	856 - Change the font.

	TOPICS:  
	New Perspectives Series: Changing the Font and Font Size

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 10:47 AM

	DATE MODIFIED:  
	7/30/2019 10:51 AM






	9. When you click the File tab and then click Print, Word immediately sends the document to the printer.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	False

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-25

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.6.2 - Print all and part of a document.

	CORPORATE STANDARDS:  
	3185 - Print a document.

	TOPICS:  
	New Perspectives Series: Previewing and Printing a Document

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 10:53 AM

	DATE MODIFIED:  
	6/18/2020 2:24 PM






	10. After using the Undo button to delete a word, you can click the Redo button to reverse the action and restore the word in the document.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-13

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.9.1 - Undo and redo actions.

	CORPORATE STANDARDS:  
	3233 - Redo an action.

	TOPICS:  
	New Perspectives Series: Formatting Paragraphs and Characters

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/30/2019 11:06 AM

	DATE MODIFIED:  
	6/10/2020 12:38 PM






	11. Click Save As in the File tab to save a document with a new name.
	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-32

	QUESTION TYPE:  
	Modified True / False

	HAS VARIABLES:  
	False

	STUDENT ENTRY MODE:  
	Basic

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.7.1 - Save a document.

	CORPORATE STANDARDS:  
	3640 - Save a document with a new name.

	TOPICS:  
	New Perspectives Series: Opening an Existing Document

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/9/2019 2:27 AM

	DATE MODIFIED:  
	8/9/2019 2:29 AM






	12. To select an entire paragraph, press CTRL+A.
	ANSWER:  
	False - document
False - Document
False - DOCUMENT

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-21

	QUESTION TYPE:  
	Modified True / False

	HAS VARIABLES:  
	False

	STUDENT ENTRY MODE:  
	Basic

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.1.6 - Move text using drag and drop.

	CORPORATE STANDARDS:  
	3776 - Select text.

	TOPICS:  
	New Perspectives Series: Adjusting Paragraph and Line Spacing

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/30/2019 11:40 AM

	DATE MODIFIED:  
	6/18/2020 2:26 PM






	13. To start Word, you click the Start button on the taskbar, and then click Word.
	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-4

	QUESTION TYPE:  
	Modified True / False

	HAS VARIABLES:  
	False

	STUDENT ENTRY MODE:  
	Basic

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.1.1.1 - Open Word.

	CORPORATE STANDARDS:  
	4313 - Start Word.

	TOPICS:  
	New Perspectives Series: Starting Word

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/9/2019 2:36 AM

	DATE MODIFIED:  
	6/18/2020 2:27 PM






	14. As you type the first few characters of a month name, AutoInsert suggests the complete text in a ScreenTip.
	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-10

	QUESTION TYPE:  
	Modified True / False

	HAS VARIABLES:  
	False

	STUDENT ENTRY MODE:  
	Basic

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.1.1 - Insert text.

	CORPORATE STANDARDS:  
	2087 - Enter text.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/9/2019 4:24 AM

	DATE MODIFIED:  
	6/18/2020 2:29 PM






	15. Use Print Layout view to adjust the document margins.
	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-24

	QUESTION TYPE:  
	Modified True / False

	HAS VARIABLES:  
	False

	STUDENT ENTRY MODE:  
	Basic

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.1 - Modify page setup.

	CORPORATE STANDARDS:  
	894 - Change the margins.

	TOPICS:  
	New Perspectives Series: Adjusting the Margins

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/9/2019 4:32 AM

	DATE MODIFIED:  
	8/9/2019 4:35 AM






	16. A numbered list is a group of related paragraphs with a black circle or other character to the left of each paragraph.
	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-56

	QUESTION TYPE:  
	Modified True / False

	HAS VARIABLES:  
	False

	STUDENT ENTRY MODE:  
	Basic

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.4.3.1 - Create numbered and bulleted lists.

	CORPORATE STANDARDS:  
	527 - Apply bullets to paragraphs.

	TOPICS:  
	New Perspectives Series: Creating Bulleted and Numbered Lists

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/9/2019 4:38 AM

	DATE MODIFIED:  
	6/18/2020 2:30 PM






	17. Use ALT to select multiple nonadjacent headings in a document.
	ANSWER:  
	False - CTRL
False - ctrl
False - Control
False - control
False - CONTROL

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-21

	QUESTION TYPE:  
	Modified True / False

	HAS VARIABLES:  
	False

	STUDENT ENTRY MODE:  
	Basic

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.2.2 - Select text.

	CORPORATE STANDARDS:  
	3769 - Select nonadjacent text.

	TOPICS:  
	New Perspectives Series: Adjusting Paragraph and Line Spacing

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 4:49 AM

	DATE MODIFIED:  
	7/31/2019 4:56 AM






	18. To help you position text and other elements in a document, you can display the _____.
	 
	a. 
	status bar

	 
	b. 
	ribbon

	 
	c. 
	rulers

	 
	d. 
	View buttons



	ANSWER:  
	c

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-2

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.1 - Modify page setup.

	CORPORATE STANDARDS:  
	4225 - Show or hide the rulers.

	TOPICS:  
	New Perspectives Series: Session 1.1 Visual Overview: The Word Window

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 6:12 AM

	DATE MODIFIED:  
	6/18/2020 2:32 PM






	19. Which of the following do you do to select text?
	 
	a. 
	press CTRL+T

	 
	b. 
	click and drag across the desired text

	 
	c. 
	right-click and drag across the desired text

	 
	d. 
	press CTRL+S



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-19

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.2.2 - Select text.

	CORPORATE STANDARDS:  
	3776 - Select text.

	TOPICS:  
	New Perspectives Series: Adjusting Paragraph and Line Spacing

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 6:21 AM

	DATE MODIFIED:  
	7/31/2019 6:26 AM






	20. Julia noticed that she accidentally used the word "then" instead of "than" in a sentence. Word identified the grammar error with a blue double underline. To correct the  error, she can do which of the following?
	 
	a. 
	Accept the suggested grammar change.

	 
	b. 
	Ignore the suggested grammar change.

	 
	c. 
	Delete the word "then."

	 
	d. 
	Change the grammar settings.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-10

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.2.2 - Correct spelling and grammar.

	CORPORATE STANDARDS:  
	5 - Accept suggested grammar change.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 6:27 AM

	DATE MODIFIED:  
	6/10/2020 12:39 PM






	21. Which of the following methods do you use to accept a spelling change?
	 
	a. 
	Right-click the misspelled word, then select the desired suggested spelling.

	 
	b. 
	Right-click the misspelled word, then press ENTER.

	 
	c. 
	Right-click the misspelled word, then select Ignore All.

	 
	d. 
	Right-click the misspelled word, then select Add to Dictionary.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-10

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.2.2 - Correct spelling and grammar.

	CORPORATE STANDARDS:  
	9 - Accept suggested spelling change.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 6:34 AM

	DATE MODIFIED:  
	7/31/2019 6:40 AM






	22. Juana needs to open a document. To access the Open dialog box, which tab should she use?
	 
	a. 
	Home tab

	 
	b. 
	View tab

	 
	c. 
	File tab

	 
	d. 
	Review tab



	ANSWER:  
	c

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-4

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.1.2.1 - Open documents.

	CORPORATE STANDARDS:  
	2995 - Open a document.

	TOPICS:  
	New Perspectives Series: Staring Word

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 6:41 AM

	DATE MODIFIED:  
	6/10/2020 12:39 PM






	23. Which of the following do you do to better view small, difficult-to-read text in a document?
	 
	a. 
	Select One Page in the window group of the View tab to enlarge the document.

	 
	b. 
	Drag the Zoom slider to enlarge the document.

	 
	c. 
	Use the navigation pane to enlarge the document.

	 
	d. 
	Hold SHIFT and use the scroll wheel to enlarge the document.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-23

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.5.2 - Customize views by using zoom settings.

	CORPORATE STANDARDS:  
	4147 - Set the zoom level.

	TOPICS:  
	New Perspectives Series: Adjusting the Margins

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 6:49 AM

	DATE MODIFIED:  
	7/31/2019 6:56 AM






	24. Jane has created a new document and entered some text. What should she do to ensure she does not lose her work?
	 
	a. 
	Save the document.

	 
	b. 
	Protect the document.

	 
	c. 
	Inspect the document.

	 
	d. 
	Close the document.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-7

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.7.1 - Save a document.

	CORPORATE STANDARDS:  
	3638 - Save a document for the first time.

	TOPICS:  
	New Perspectives Series: Saving a Document

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 6:57 AM

	DATE MODIFIED:  
	7/31/2019 7:04 AM






	25. Which of the following refers to a printed line that surrounds the outer part of a page?
	 
	a. 
	Page Border

	 
	b. 
	Page Boundary

	 
	c. 
	Page Margin

	 
	d. 
	Page Edge



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-55

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.8 - Format page background elements.

	CORPORATE STANDARDS:  
	147 - Add a page border.

	TOPICS:  
	New Perspectives Series: Adding a Page Border

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 7:06 AM

	DATE MODIFIED:  
	7/31/2019 7:10 AM






	26. If you mistakenly undo an action, how do you correct your mistake?
	 
	a. 
	Click the Undo button on the Quick Access toolbar.

	 
	b. 
	Press CTRL+R.

	 
	c. 
	Click the Redo button on the Quick Access toolbar.

	 
	d. 
	Press CTRL+Z.



	ANSWER:  
	c

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-13

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.9.1 - Undo and redo actions.

	CORPORATE STANDARDS:  
	3233 - Redo an action.

	TOPICS:  
	New Perspectives Series: Formatting Paragraphs and Characters

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 7:18 AM

	DATE MODIFIED:  
	6/10/2020 12:40 PM






	27. Kate needs to insert 10 text boxes in a document. After inserting the first text box, how can she easily repeat the action nine more times?
	 
	a. 
	Right-click the text box border and select Repeat nine times.

	 
	b. 
	Click the Repeat button nine times.

	 
	c. 
	Cut the text box and then paste it.

	 
	d. 
	Press CTRL+R nine times.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-13

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.9.1 - Undo and redo actions.

	CORPORATE STANDARDS:  
	3348 - Repeat an action.

	TOPICS:  
	New Perspectives Series: Formatting Paragraphs and Characters

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 7:23 AM

	DATE MODIFIED:  
	6/10/2020 12:41 PM






	28. Dan needs to view his document as it will appear after being printed. Which view should he use?
	 
	a. 
	Read Mode

	 
	b. 
	Print Layout

	 
	c. 
	Web Layout

	 
	d. 
	Outline View



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-6

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.5.1 - Change document views.

	CORPORATE STANDARDS:  
	4365 - Switch to Print Layout.

	TOPICS:  
	New Perspectives Series: Setting Up the Word Window

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 7:30 AM

	DATE MODIFIED:  
	7/31/2019 7:36 AM






	29. Jessica encounters text in a document that appears blue and underlined. When she presses CTRL and clicks the text, she is taken to a website. She wants the text to appear and behave like normal text. Which of the following should she do?
	 
	a. 
	Right-click the text and select Remove Hyperlink.

	 
	b. 
	Change the font color and remove the underline using buttons in the Font group of the Home tab.

	 
	c. 
	Delete the text and then retype it.

	 
	d. 
	Leave the text as is; it will appear normal when the document is printed.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-13

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.3.2 - Manage hyperlinks.

	CORPORATE STANDARDS:  
	3276 - Remove a hyperlink.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 7:37 AM

	DATE MODIFIED:  
	7/31/2019 7:42 AM






	30. In an informal document, you can format text to stand out by applying a _____.
	 
	a. 
	text effect

	 
	b. 
	type effect

	 
	c. 
	type style

	 
	d. 
	design style



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-41

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	453 - Apply a preset text effect.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 7:43 AM

	DATE MODIFIED:  
	6/18/2020 2:40 PM






	31. Which of the following should Tim use to italicize text?
	 
	a. 
	Select some italicized text in the document, click the Format Painter button, and then select the text to italicize.

	 
	b. 
	Select the text that needs to be italicized,  click the Format Painter button, and then select some italicized text in the document.

	 
	c. 
	Click the Format Painter button, click the Italic button in the Font group, and then select the text to italicize.

	 
	d. 
	Select the text to italicize, and then click the Text Effects button in the Font group.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-41

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	2759 - Italicize text.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 8:53 AM

	DATE MODIFIED:  
	6/10/2020 12:43 PM






	32. Jared needs more space between lines of text in a paragraph. Which of the following is the best method to use for this action?
	 
	a. 
	Drag the Zoom slider to increase the line spacing.

	 
	b. 
	Press ENTER at the end of each line to create a space between lines.

	 
	c. 
	Press the Line and Paragraph Spacing button in the Paragraph group on the Home tab, then select the desired amount of spacing.

	 
	d. 
	Enter the Indents and Spacing tab of the Paragraph dialogue box and increase the value of the text box labeled "After:".



	ANSWER:  
	c

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-19

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.4 - Alter line and paragraph spacing and indentation.

	CORPORATE STANDARDS:  
	930 - Change the paragraph spacing.

	TOPICS:  
	New Perspectives Series: Adjusting Paragraph and Line Spacing

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 9:03 AM

	DATE MODIFIED:  
	7/31/2019 9:11 AM






	33. Sarah wants to quickly apply a Picture Border and Picture Effect to a picture. Which of the following can she use to do this?
	 
	a. 
	Apply a Picture Style.

	 
	b. 
	Change the Theme Effects.

	 
	c. 
	Apply an Artistic Effect.

	 
	d. 
	Apply a Correction.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-53

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.6.2.5 - Apply styles to objects.

	CORPORATE STANDARDS:  
	446 - Apply a picture style.

	TOPICS:  
	New Perspectives Series: Inserting a Picture and Adding Alt Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	7/31/2019 9:47 AM

	DATE MODIFIED:  
	7/31/2019 10:09 AM






	34. Which of the following do you use to change the document margins?
	 
	a. 
	Use the Orientation button in the Page Setup group of the Layout tab to select the desired option.

	 
	b. 
	Use the Margins button in the Page Setup group of the Layout tab to select the desired option.

	 
	c. 
	Use the Size button in the Page Setup group of the Layout tab to select the desired option.

	 
	d. 
	Use the Columns button in the Page Setup group of the Layout tab to select the desired option.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-24

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.1 - Modify page setup.

	CORPORATE STANDARDS:  
	894 - Change the margins.

	TOPICS:  
	New Perspectives Series: Adjusting the Margins

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 10:16 AM

	DATE MODIFIED:  
	7/31/2019 10:23 AM






	35. Where do the rulers appear in the Word window?
	 
	a. 
	On the left side of the title bar

	 
	b. 
	Directly above the status bar

	 
	c. 
	On the Home tab

	 
	d. 
	Above and to the left of the document



	ANSWER:  
	d

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-2

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.1 - Modify page setup.

	CORPORATE STANDARDS:  
	4225 - Show or hide the rulers.

	TOPICS:  
	New Perspectives Series: Session 1.1 Visual Overview: The Word Window

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 10:24 AM

	DATE MODIFIED:  
	6/18/2020 2:42 PM






	36. Amanda entered a bulleted list of topics. She wants to move one bulleted item to the right and make it a subtopic. Which of the following should she do?
	 
	a. 
	Change the bullet to a number.

	 
	b. 
	Click the Increase Indent button in the Paragraph group.

	 
	c. 
	Click the Bullets arrow and select a different bullet.

	 
	d. 
	Click the Decrease Indent button in the Paragraph group.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-58

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.4.4.3 - Increase and decrease list levels.

	CORPORATE STANDARDS:  
	2406 - Increase the indent of a list item.

	TOPICS:  
	New Perspectives Series: Creating Bulleted and Numbered Lists

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 10:31 AM

	DATE MODIFIED:  
	6/10/2020 12:44 PM






	37. Which of the following is the most efficient way to change the font size from 24 points to 22 points?
	 
	a. 
	Click the Decrease Font Size button.

	 
	b. 
	Apply a text effect.

	 
	c. 
	Click the Emphasis button.

	 
	d. 
	Click the Change Size button.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-42

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.2 - Change document themes.

	CORPORATE STANDARDS:  
	1713 - Decrease the font size by two points.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 10:39 AM

	DATE MODIFIED:  
	6/18/2020 2:44 PM






	38. Which view most closely resembles how your document will look when printed?
	 
	a. 
	Web Layout

	 
	b. 
	Read Mode

	 
	c. 
	Print Layout

	 
	d. 
	Page Layout



	ANSWER:  
	c

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-6

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.5.1 - Change document views.

	CORPORATE STANDARDS:  
	4365 - Switch to Print Layout.

	TOPICS:  
	New Perspectives Series: Setting Up the Word Window

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 10:59 AM

	DATE MODIFIED:  
	6/10/2020 12:45 PM






	39. Jasmine needs to select the first sentence of a paragraph and the last sentence of a paragraph simultaneously. The text is nonadjacent. Which of the following should she do?
	 
	a. 
	Select the first sentence, then press and hold ALT while selecting the second sentence.

	 
	b. 
	Select the first sentence, then press and hold SHIFT while selecting the second sentence.

	 
	c. 
	Select the first sentence, then press and hold SHIFT+ALT while selecting the second sentence.

	 
	d. 
	Select the first sentence, then press and hold CTRL while selecting the second sentence.



	ANSWER:  
	d

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-21

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.2.2 - Select text.

	CORPORATE STANDARDS:  
	3769 - Select nonadjacent text.

	TOPICS:  
	New Perspectives Series: Adjusting Paragraph and Line Spacing

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 11:13 AM

	DATE MODIFIED:  
	7/31/2019 11:19 AM






	40. Which of the following options allows you to align text so that it is fully flush with both margins?
	 
	a. 
	Align Left

	 
	b. 
	Center

	 
	c. 
	Align Right

	 
	d. 
	Justify



	ANSWER:  
	d

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-43

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.8.1.9 - Set paragraph pagination and formatting options.

	CORPORATE STANDARDS:  
	343 - Align a paragraph.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 11:20 AM

	DATE MODIFIED:  
	7/31/2019 11:26 AM






	41. Joe accidentally deleted a paragraph. Which of the following is the fastest way to restore the paragraph?
	 
	a. 
	Undo the action.

	 
	b. 
	Redo the action.

	 
	c. 
	Repeat the action.

	 
	d. 
	Reenter the text manually.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-13

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.9.1 - Undo and redo actions.

	CORPORATE STANDARDS:  
	4423 - Undo an action.

	TOPICS:  
	New Perspectives Series: Using the Undo and Redo Buttons

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 11:27 AM

	DATE MODIFIED:  
	6/10/2020 12:46 PM






	42. A document contains a list of items that appear in no particular order. Which of the following is the best way to format the list?
	 
	a. 
	Apply numbering to the list.

	 
	b. 
	Apply bullets to the list.

	 
	c. 
	Apply multilevel numbering to the list.

	 
	d. 
	Manually enter a ">" character at the beginning of each item in the list.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-56

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.4.3.1 - Create numbered and bulleted lists.

	CORPORATE STANDARDS:  
	527 - Apply bullets to paragraphs.

	TOPICS:  
	New Perspectives Series: Creating Bulleted and Numbered Lists

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 11:36 AM

	DATE MODIFIED:  
	7/31/2019 11:43 AM






	43. In a formal, professional document, which of the following can you apply to make a word stand out?
	 
	a. 
	italic formatting

	 
	b. 
	preset text effect

	 
	c. 
	paragraph style

	 
	d. 
	page border



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-41

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	2759 - Italicize text.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 11:44 AM

	DATE MODIFIED:  
	6/18/2020 2:47 PM






	44. Karen has a document with a list of five priorities in separate paragraphs. The priorities are listed in order from most important to least important. Which of the following options is the best way to format this list?
	 
	a. 
	Bulleted list

	 
	b. 
	Numbered list

	 
	c. 
	Multilevel bulleted list

	 
	d. 
	Paragraph shading



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-58

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.4.3.1 - Create numbered and bulleted lists.

	CORPORATE STANDARDS:  
	533 - Apply numbering to paragraphs.

	TOPICS:  
	New Perspectives Series: Creating Bulleted and Numbered Lists

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 11:53 AM

	DATE MODIFIED:  
	6/10/2020 12:46 PM






	45. Samantha needs to create a numbered series of paragraphs. Which of the following should she do? Select all that apply.
	 
	a. 
	Select the paragraphs, click the Numbering arrow in the Paragraph group, and then click a numbering style.

	 
	b. 
	Select the paragraphs, and then click the Numbering button in the Paragraph group.

	 
	c. 
	Enter ">" and then press SPACEBAR to begin numbering.

	 
	d. 
	Select the paragraphs and then press CTRL+N.



	ANSWER:  
	a, b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-58

	QUESTION TYPE:  
	Multiple Response

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.4.3.1 - Create numbered and bulleted lists.

	CORPORATE STANDARDS:  
	533 - Apply numbering to paragraphs.

	TOPICS:  
	New Perspectives Series: Creating Bulleted and Numbered Lists

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 12:16 PM

	DATE MODIFIED:  
	6/10/2020 12:48 PM






	46. To view the entire page of a document, which of the following should you do?
	 
	a. 
	Press the 100% button on the Zoom group of the View tab.

	 
	b. 
	Press the One Page button on the Zoom group of the View tab.

	 
	c. 
	Press the Page Width button on the Zoom group of the View tab.

	 
	d. 
	Slide the Zoom slider toward the plus symbol.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-23

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.5.2 - Customize views by using zoom settings.

	CORPORATE STANDARDS:  
	4147 - Set the zoom level.

	TOPICS:  
	New Perspectives Series: Adjusting the Margins

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	7/31/2019 12:02 PM

	DATE MODIFIED:  
	7/31/2019 12:14 PM






	47. Tom needs to make the font size of selected text larger. He should do which of the following? Select all the options that apply.
	 
	a. 
	Change the Zoom level.

	 
	b. 
	Click the Font arrow in the Font group, and then click a font.

	 
	c. 
	Click the Font Size arrow in the Font group, and then click a font size.

	 
	d. 
	Click the Increase Font Size button in the Font group.



	ANSWER:  
	c, d

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-39

	QUESTION TYPE:  
	Multiple Response

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	853 - Change the font size.

	TOPICS:  
	New Perspectives Series: Changing the Font and Font Size

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/1/2019 3:38 AM

	DATE MODIFIED:  
	6/10/2020 12:55 PM






	48. Jeremy wants to make some text stand out in a document. Which of the following can he do? Select all the options that apply.
	 
	a. 
	Bold the text.

	 
	b. 
	Decrease the font size.

	 
	c. 
	Apply a text effect.

	 
	d. 
	Italicize the text.



	ANSWER:  
	a, c, d

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-41

	QUESTION TYPE:  
	Multiple Response

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	630 - Bold text.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/1/2019 6:15 AM

	DATE MODIFIED:  
	6/10/2020 1:02 PM






	49. In which of the following ways can you format a word in a paragraph? Select all the options that apply.
	 
	a. 
	Change the alignment.

	 
	b. 
	Change the font.

	 
	c. 
	Change the line spacing.

	 
	d. 
	Change the font size.



	ANSWER:  
	b, d

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-39

	QUESTION TYPE:  
	Multiple Response

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	856 - Change the font.

	TOPICS:  
	New Perspectives Series: Changing the Font and Font Size

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/1/2019 6:22 AM

	DATE MODIFIED:  
	6/10/2020 1:03 PM






	50. To find a word in a document, use the Smart Lookup feature.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	False

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-60

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.2.3 - Find synonyms.

	CORPORATE STANDARDS:  
	1901 - Display the Smart Lookup pane.

	TOPICS:  
	New Perspectives Series: Getting Help

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 6:43 AM

	DATE MODIFIED:  
	8/1/2019 6:47 AM






	51. Dan is writing a novel that contains the nonsense word "Zerphron", which Word identifies as a spelling error. To prevent Word from identifying "Zerphron" as a misspelled word, he can select the Ignore All option.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-10

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.2.2 - Correct spelling and grammar.

	CORPORATE STANDARDS:  
	2352 - Ignore all instances of suggested spelling change.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 6:52 AM

	DATE MODIFIED:  
	8/1/2019 7:13 AM






	52. To ensure a document is free of typos, always do which of the following before publishing the document.
	 
	a. 
	Check the document for accessibility by clicking the Check Accessibility button.

	 
	b. 
	Check the document for spelling and grammar errors by clicking the Spelling & Grammar button.

	 
	c. 
	Use Smart Lookup by clicking the Smart Lookup button.

	 
	d. 
	Check the document for compatibility by clicking the Check Compatibility button.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-31

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.2.1 - Check spelling and grammar.

	CORPORATE STANDARDS:  
	1142 - Check spelling and grammar.

	TOPICS:  
	New Perspectives Series: Creating an Envelope

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 7:21 AM

	DATE MODIFIED:  
	8/1/2019 7:28 AM






	53. Andrew accidentally misspelled a word. To correct the error, he can do which of the following?
	 
	a. 
	Right-click the word and select the desired suggested spelling.

	 
	b. 
	Right-click the word and select Smart Lookup.

	 
	c. 
	Right-click the word and select Link.

	 
	d. 
	Right-click the word and select Translate.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-31

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.2.2 - Correct spelling and grammar.

	CORPORATE STANDARDS:  
	1342 - Correct a spelling or grammar mistake.

	TOPICS:  
	New Perspectives Series: Creating an Envelope

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 7:30 AM

	DATE MODIFIED:  
	8/1/2019 7:48 AM






	54. Terry entered the word "teh" intentionally as a nonsense word, but AutoCorrect changed the word to "the". To change the word back to "teh", he should do which of the following? Select all that apply.
	 
	a. 
	Press CTRL+Z.

	 
	b. 
	Hover the cursor over the word, press the AutoCorrect icon, and then select the appropriate option.

	 
	c. 
	Press CTRL+Y.

	 
	d. 
	Hover the cursor over the word, press the AutoCorrect icon, and then select the appropriate option.



	ANSWER:  
	a, b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-14

	QUESTION TYPE:  
	Multiple Response

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.9.1 - Undo and redo actions.

	CORPORATE STANDARDS:  
	4425 - Undo an automatic correction.

	TOPICS:  
	New Perspectives Series: Using the Undo and Redo Buttons

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	8/1/2019 8:07 AM

	DATE MODIFIED:  
	8/1/2019 8:13 AM






	55. To copy formatting from one selection of text to another, use the Format Painter.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-48

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.2 - Apply text formatting by using format painter.

	CORPORATE STANDARDS:  
	4555 - Use the Format Painter with text.

	TOPICS:  
	New Perspectives Series: Copying Formatting with the Format Painter

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 9:19 AM

	DATE MODIFIED:  
	8/1/2019 9:25 AM






	56. The only way to decrease the font size of text is to use the Font Size button.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	False

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-42

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	1713 - Decrease the font size by two points.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Font Styles

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 9:34 AM

	DATE MODIFIED:  
	6/18/2020 2:48 PM






	57. Tiana wants a line to appear around a paragraph. She should do which of the following?
	 
	a. 
	Add a paragraph border.

	 
	b. 
	Add paragraph shading.

	 
	c. 
	Apply a text effect.

	 
	d. 
	Apply a character style.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-45

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.8.1.9 - Set paragraph pagination and formatting options.

	CORPORATE STANDARDS:  
	150 - Add a paragraph border.

	TOPICS:  
	New Perspectives Series: Adding a Paragraph Border and Shading

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 10:11 AM

	DATE MODIFIED:  
	8/1/2019 10:18 AM






	58. Aniyah needs to insert the date and time in her document. She should do which of the following?
	 
	a. 
	Click the Insert Date and Time button and select the desired option.

	 
	b. 
	Click the Cross-reference button.

	 
	c. 
	Click the Table button and select the desired option.

	 
	d. 
	Click the Link button and select the desired option.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-11

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.5 - Manage headers and footers.

	CORPORATE STANDARDS:  
	2729 - Insert the date and time.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 10:27 AM

	DATE MODIFIED:  
	8/1/2019 10:31 AM






	59. Caleb needs to create an outline with Roman numerals and uppercase letters. He should do which of the following?
	 
	a. 
	Create a multilevel list.

	 
	b. 
	Create a single-level bulleted list.

	 
	c. 
	Create a single-level numbered list.

	 
	d. 
	Create a outline list.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-59

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.4.3.1 - Create numbered and bulleted lists.

	CORPORATE STANDARDS:  
	1538 - Create a multilevel list.

	TOPICS:  
	New Perspectives Series: Creating Bulleted and Numbered Lists

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 10:50 AM

	DATE MODIFIED:  
	6/10/2020 1:04 PM






	60. Which of the following do you need to enter when you create an envelope?
	 
	a. 
	Delivery address

	 
	b. 
	Closing line

	 
	c. 
	Electronic postage amount

	 
	d. 
	Outside address



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-28

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.4.2 - Insert page, section, and column breaks.

	CORPORATE STANDARDS:  
	1619 - Create an envelope.

	TOPICS:  
	New Perspectives Series: Creating an Envelope

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 11:18 AM

	DATE MODIFIED:  
	6/18/2020 2:50 PM






	61. Hyperlinks can only point to webpages.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	False

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-12

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.3.1 - Insert hyperlinks.

	CORPORATE STANDARDS:  
	2537 - Insert a hyperlink to an email address.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 11:24 AM

	DATE MODIFIED:  
	8/1/2019 11:27 AM






	62. When you type an email address and then press ENTER, what does Word do?
	 
	a. 
	Increases the font size of the email address

	 
	b. 
	Converts the email address to a hyperlink

	 
	c. 
	Converts the email address to a heading

	 
	d. 
	Shades the email address



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-12

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.3.1 - Insert hyperlinks.

	CORPORATE STANDARDS:  
	2537 - Insert a hyperlink to an email address.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 11:31 AM

	DATE MODIFIED:  
	6/10/2020 1:05 PM






	63. To enable people reading a document to easily send an email to an email address, which of the following should be done?
	 
	a. 
	Insert the email address as a hyperlink.

	 
	b. 
	Insert the email address in the document header.

	 
	c. 
	Insert the email address as SmartArt.

	 
	d. 
	Insert the email address as WordArt.



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-12

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.3.1 - Insert hyperlinks.

	CORPORATE STANDARDS:  
	2537 - Insert a hyperlink to an email address.

	TOPICS:  
	New Perspectives Series: Entering Text

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 11:42 AM

	DATE MODIFIED:  
	8/1/2019 11:47 AM






	64. To set a document's page layout to landscape, change the page orientation.
	 
	a. 
	True

	 
	b. 
	False



	ANSWER:  
	True

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-38

	QUESTION TYPE:  
	True / False

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.2.4.1 - Modify page setup.

	CORPORATE STANDARDS:  
	911 - Change the orientation of a page.

	TOPICS:  
	New Perspectives Series: Changing Page Orientation

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 11:47 AM

	DATE MODIFIED:  
	8/1/2019 11:52 AM






	65. Jared needs to create and address an envelope. After creating a new blank document, which of the following options should he select on the Mailings tab?
	 
	a. 
	Letters

	 
	b. 
	E-mail messages

	 
	c. 
	Envelopes

	 
	d. 
	Labels



	ANSWER:  
	c

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-27

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.10.4.8 - Create mailing labels, envelopes and directories.

	CORPORATE STANDARDS:  
	1619 - Create an envelope.

	TOPICS:  
	New Perspectives Series: Creating an Envelope

	KEYWORDS:  
	Bloom's: Understand

	DATE CREATED:  
	8/1/2019 11:53 AM

	DATE MODIFIED:  
	6/10/2020 1:06 PM






	66. Which of the following do you enter in the Envelopes and Labels dialog box to create an envelope?
	 
	a. 
	Delivery address

	 
	b. 
	Postage amount

	 
	c. 
	Envelope type

	 
	d. 
	Recipient's email address



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-27

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.10.4.8 - Create mailing labels, envelopes and directories.

	CORPORATE STANDARDS:  
	1619 - Create an envelope.

	TOPICS:  
	New Perspectives Series: Creating an Envelope

	KEYWORDS:  
	Bloom's: Apply

	DATE CREATED:  
	8/1/2019 11:58 AM

	DATE MODIFIED:  
	6/10/2020 1:08 PM






	67. To create an envelope, you start by clicking the _____ tab on the ribbon.
	 
	a. 
	Mailings

	 
	b. 
	Layout

	 
	c. 
	Design

	 
	d. 
	Mail Merge



	ANSWER:  
	a

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-27

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.10.4.8 - Create mailing labels, envelopes and directories.

	CORPORATE STANDARDS:  
	1619 - Create an envelope.

	TOPICS:  
	New Perspectives Series: Creating an Envelope

	KEYWORDS:  
	Bloom's: Analyze

	DATE CREATED:  
	8/1/2019 12:02 PM

	DATE MODIFIED:  
	6/18/2020 2:52 PM






	68. Which of the following describes how to change the font color?
	 
	a. 
	Click the Shading arrow in the Paragraph group, and then click a color.

	 
	b. 
	Click the Font Color button in the Font group.

	 
	c. 
	Click the Design tab, and then click the Fonts button in the Document Formatting group.

	 
	d. 
	Click the Design tab, and then click the Theme Effects button in the Document Formatting group.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-46

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.3.3.1 - Modify text formatting.

	CORPORATE STANDARDS:  
	840 - Change the font color.

	TOPICS:  
	New Perspectives Series: Adding a Paragraph Border and Shading

	KEYWORDS:  
	Bloom's Remember

	DATE CREATED:  
	6/10/2020 12:49 PM

	DATE MODIFIED:  
	6/10/2020 12:53 PM






	69. Alyssa needs to center the text of a paragraph on the page. Which of the following can she do?
	 
	a. 
	Click the Middle button in the Paragraph group.

	 
	b. 
	Click the Center button in the Paragraph group.

	 
	c. 
	Click the Align button in the Paragraph group.

	 
	d. 
	Click the Justify button in the Paragraph group.



	ANSWER:  
	b

	POINTS:  
	1

	REFERENCES:  
	NPWD 1-43

	QUESTION TYPE:  
	Multiple Choice

	HAS VARIABLES:  
	False

	LEARNING OBJECTIVES:  
	NPWD.CARE.20.8.1.9 - Set paragraph pagination and formatting options.

	CORPORATE STANDARDS:  
	343 - Align a paragraph.

	TOPICS:  
	New Perspectives Series: Applying Text Effects, Font Colors, and Formatting

	KEYWORDS:  
	Bloom's: Remember

	DATE CREATED:  
	6/10/2020 12:57 PM

	DATE MODIFIED:  
	6/10/2020 1:00 PM







	Copyright Cengage Learning. Powered by Cognero.
	Page 



